
Animating in Maya 

Animation in Maya is primarily key frame animation. The timeline splits time up into ‘frames’; 

usually (for UK TV) 25 frames per second. For each frame then, you can ‘key’ any of an objects 

attributes (translation for example) to hold that value at that frame. 

Key Frame 

Probably the most commonly renowned styles of animation used within todays’ industry is key 

frame animation. This involves positioning your character at a specific frame on the timeline 

to determine its appearance at that specific moment, key the relevant attributes and then move 

onto the point in time. When we scrub through the timeline we will see our character moving 

and deforming between each of our set frames. 

Maya will then connect these keys together into a curve, working out in-between values. 

This means you can very quickly get nice fluid animation, using only a few key frames. 

 

Graph Editor 

The graph editor (shown with the above cube 

animation) illustrates the keyed elements along the 

translate axis. As you can see from the diagram the 

attributes in question are colour coded, and each tell us 

information about how the animation will playback. We 

will have a more in depth look into the graph editor 

during our animation tutorials later in this section. 

  



Translate X:  

The cube moves from a value of minus three to three over the course of 

eight frames. We could have a straight line here, but by using flat 

tangents on the start and end points we ensure that the cube eases in and out of the animation.  

Translate Y:  

The cube moves from the floor, into the air and back onto the floor. This is shown by the green 

curve in the shape of a hump. Again we have flattened out our tangents to ease in and out of 

the animation. 

Path Animation: 

You can make an object follow the path of a 

CV curve using motion paths. The motion 

path start and end time can then be 

manipulated to control the amount of time 

that the object travels along the curve for and 

other attributes can be set for twisting and 

banking relative to the curve bend. These 

make it easier when an object needs to be 

rotated 90° to face forwards, for example. 

Motion paths are most often used to move on object (such as a car) or a character with an animated 

walk cycle along a specific route. In both of these cases, to avoid wheel or foot ‘ghosting’ you will need 

to match the timing of the wheel rotation or walk cycle to the start and end frame of the motion path 

relative to the distance of the path. This is easy to calculate however, in the command bar, type arclen 

<object name> which will return the length of the curve. You can then use this number to divide the 

distance travelled per walk cycle by, giving you the number of cycles during the motion path. Multiply 

the number of cycles by the time it takes to do one cycle, and this will give you the total length of time 

for the motion path. 

You can also use motion paths for advanced rigging techniques, such as tank tracks or making an object 

follow the curvature of an animated creature, but these are more advanced techniques that we will cover 

in future resources. 

Expressions 

Expressions are small snippets of code that are evaluated by Maya for each frame. These are 

used primarily for dynamics and particle systems, for example emitting particles when two 

rigid objects collide. 



Set Driven Key 

Used to set up interactions between attributes whereby the driver, drives the driven. The 

unique feature of this tool is that the relationship is keyed between the driver and driven nodes, 

which means you can view and edit the relationship in the graph editor and take advantage of 

your curve editing tools. By driving multiple nodes from a single driver you can create some 

nice fluid animation that is keyable within your scene (for example our reverse foot lock that 

we have set up on page 152). 

Animation Layers 

Animation layers give you multiple levels of animation that add together to give you a final 

result. For example, during the walk cycle we have created, we could create a new animation 

layer called head turn, and animate our head turning to face the camera a few steps into our 

animation and then back to default again. 

Because our two animation layers are separate to each other, we can easily edit one without 

worrying about affecting the other. 

 

  



Useful Animation Techniques 

Silhouettes 

When you are animating, especially while you are creating key poses it is valuable to check 

the silhouette of your character. This is a key instrument in keeping your gestures powerful 

and interesting for your audience. 

In Maya a simple way to view your scene silhouette is to uncheck Use All Lights in your 

Viewport > Lighting menu and then also check Use Default Material in your Viewport > 

Shading menu. This stops any of your lights affecting the viewport (your character will turn 

flat) and then forces the viewport to use the default Maya material lambert1. Now all we need 

to do is change the lambert1 diffuse colour to black in our Hypershade window. 

This gives us a nice silhouette of our character, without changing the scene itself (when we 

hit render, the scene will render out as before). 

Smart Blocking 

We can apply our principles of animation such as follow through during our pose to pose stage 

and include them in our key poses. This gives us a much more powerful bases for when we 

come in and fill the detail between poses. 

We can also go in and tweak the finer details such as fingers and other secondary details at 

this stage. Check against your silhouette in your camera view while you are creating your 

poses to check the emotion and exaggeration is correct. You want to make each pose as 

interesting as possible. 

Moving Holds 

Moving Holds are an important device to let the audience read what the character is doing and 

second guess what the character may be thinking. The easiest way to create a moving hold 

is to go to the key you wish to extend the hold until and then middle-click the key where the 

hold starts. You will notice that the animation does not change, so now if you key your 

attributes (press ‘S’ to key everything) it will key your original key frame with the value of the 

one your middle-clicked. 

Motion Trails / Ghosting 

An easy and visual way to check our animation arcs is to use Motion Trails which can be 

accessed in our Animation menu set (F2) and then Animate > Create Editable Motion Trail □. This 

will display a curve along the motion path of the selected object, including the location of any 

keys on that curve. New to recent revisions of Maya is the ability to move these keys in physical 



space, or even change the frame number that they fall under giving us near graph editor 

control in 3D space. 

Ghosting is more suitable to checking our ease in and ease out keys. Still in your Animation 

menu set, Animate > Ghost Selected will show the selected objects previous and future 

locations by about three steps. Correct ease in and out is displayed by the frames getting 

closer together or further away respectively. 

The feet and hands in this imaged are Ghosted: 

  



Animating a Tennis Ball 

This tutorial will teach you the main principles of animation, specifically how to animate a tennis 

ball being fired from a cannon and bouncing off a wall to a stop. 

We would recommend you use your own 

scene for this as all you really need is a poly 

sphere to represent the tennis ball and a 

poly cube to represent the wall. If you are 

feeling extra adventurous you could build a 

tennis ball launcher like we have built in our 

scene. Make sure that you freeze your 

transformations Modify > Freeze 

Transformations and delete any history 

Shift-Alt-D before you start animating. 

First let’s plan our animation. We want the ball to launch towards the wall at a slight upwards 

angle and then bounce off the wall, fly over the tennis launcher and bounce on the floor a few 

times before it comes to a stop. The ball will drop slightly as it is flung, but will lose speed and 

drop at a steeper angle after each bounce. 

Most likely your time slider is set to 48 frames, we are going to 

increase this to 100 to give us more time to play with. 

Ensuring we are at the frame one, select the ball and press Shift-W 

to key the translation in its starting position. We only want to create 

key frames for the attributes that we are animating; this keeps the 

time slider and graph editor clean and simple if we want to go in and 

change things. It also allows us to control other attributes such as 

rotation and scale without worrying about previous key frames 

getting in the way. 

  



Move the time slider to frame six and in the side view 

move the ball to the wall in the x axis and up in the y 

axis by about one fifth of the distance and set another 

key frame. 

Now move the time slider further on to frame 20 and 

move the ball back behind the launcher and on the 

ground. If you play back the animation now, you will 

see that it is missing something – the ‘bounce’ off the 

wall is too soft and the ball leaves the wall in the wrong 

direction – it should bounce upwards first and then 

drop. 

 Open your graph editor Window > Animation 

Editors > Graph Editor and press F to frame the key 

frames. Select the first key frame, at the moment it 

has Flat tangents which means the ball will ease 

into the animation – because we are firing the ball 

straight from a cannon we want to change the 

tangents to linear tangents. This will give us an 

instant trajectory. In similar vein we want to change our 

other keys to linear because they are currently all impact 

points where the ball will bounce. 

  



The bounce speed is more accurate, but we still need to 

make the ball continue upwards a little after the bounce. 

Move to frame 11 and move the ball up in the Y Axis. Right-

click hold the Translate Y attribute and select Key Selected. 

Keying the attribute individually ensures that the other 

translate values are not inhibited. 

Now we want to use this method of animation to 

make the bounce again on the floor. When you 

have set your keys and are in the graph editor, 

one extra too we will need to use is the Break 

Tangents button. This allows us to move the in 

and out tangents independently. To change our 

tangents (the yellow lines coming from the point) make sure you are in 

move mode (W key) select the line and middle-click drag to change its 

direction. 

Using the same techniques, add another couple 

of bounces, reducing the length and height each 

time. Your graph editor should resemble 

something similar to the one on the left. 

Before we finish, we are going to add some back 

spin to the 

ball. At frame one key the ball’s Rotate X attribute at zero 

and then on our last frame set the value to something like 

1000. The initial key should be made linear to resemble the 

curve on the right. 

Play with the in and out curves to get the correct bounce speed, and you should be left with a 

simple ball being fired into a wall and bouncing back. 

  



Creating a Walk Cycle 

A walk cycle is one of the most important and often most overlooked part of animation. The 

walk cycle is vital to making your character believable – in the same way that you can discern 

you friends from their body language alone, it is the subtleties in the weight and balance 

distribution that makes a good walk cycle. 

Character Rigs 

For the most part we have always recommended that you use your own models, your own 

rigs and apply our techniques to your own scene. If you already have a suitable rigged 

character that is animation ready then load it up, but if you are more interested in getting stuck 

into animation that modelling and rigging then we recommend that you use one of many freely 

available rigs. We recommend the popular ‘Andy Rig’ created by John Doublestein. 

Designed specifically for students it has all the control systems we could want including IK/FK 

switches and squash stretch. 

Animating the Walk Cycle 

First we need to double check our animation preferences. Open up your Window > Settings 

Preferences > Preferences window and under the Settings tab make sure that our Time is set 

to 25 fps (standard UK PAL). Under the Animation tab set both the Default In tangent and 

Default out tangent to plateau. This will give our keep our key frames flat by default. 

Now let’s set up our project. Under the File 

menu click Set Project and then create a new 

folder with your project name, let’s call it 

walkCycle. If a dialogue pops up, select Create default 

workspace. Now to finalise our project and create our 

subfolders, simply click on Project Window in the File menu and 

then Accept the default folder names. 

  



Copy your character rig into the assets folder, then back Maya click Create 

Reference from your File menu. Click on Assets from the left hand menu and 

select the rig your wish to animate with. 

While we are still setting the scene up, change the 

playback range to 33. This is going to be the length 

of our walk cycle. 

In your viewport Show menu, select None to hide all objects and then tick 

NURBS Curves, NURBS Surfaces and Polygons to make them visible.  This 

will keep any joints and other visible objects hidden while we are animating. 

Select all of your controls (if you are working with your own rig then make 

sure that only controls are selected, not your mesh or any other nodes that 

could break if keys are applied). We can also turn on our Auto Keyframe toggle on in the 

bottom right.  

We have four key points during our walk cycle, causing our characters 

centre of gravity to create a wave pattern. Frames 5, and 21 are when the 

hips will be at their lowest, frames nine and 25 the highest. Let’s plug some 

values in to give us this bob to work with. Make sure you are at frame one 

and key the hips Translate Y at zero, then key the value on frames 17 and 

33. Move to frame five and bring the hips down, auto key should have 

created a new key for us. To set this same value you for frame 21, middle 

click on frame 21. You will see that the animation does not update, but if we key the Translate 

Y attribute it will create a new key with the previous value. This technique is also great for 

keying hold poses. Now on frames nine and 13 and then 13 and 29 key the hips in a more 

elevated position to give us a nice smooth bobbing effect. 

Open up your Graph Editor and press ‘F’ to frame 

up your translate curve. In the Curves menu select 

Pre-Infinity > Cycle and Post-Infinity > Cycle. This will force the curves into 

a loop and to show us this loop we can enable the Infinity box in the view 

menu.  

  



This will give us a dotted line either side of our key 

frames to show us how the value will continue. At the 

moment our loop has this ‘step’ or kink at the 

beginning. Select the first key frame and then shift select the last and press ‘flat tangents’ to 

make sure they are the same. Now select and shift select the tangents for the key frames and 

in ensuring you are in move mode (W) move the tangents down so that the curve is smooth. 

Go back to frame one and move the feet into position (starting with your left 

foot leading) watching for any hyper-extension. We never want any of our 

limbs to be completely locked out because this will cause ‘popping’ to occur 

during our animation. We want to bring the rest of our character into a rough 

start pose. Rotate the body forwards a little and also rotate our hips to follow 

along with our legs. Your feet may be different if you are using your own 

character, but we are going to use our Foot Roll attribute on our foot controls 

to bring the toes up and heel forwards for our respective feet. We also want to 

ensure that auto stretch is turned off. 

In our upper body, we want to bring our arms down and out (do not rotate 

them forward too far) and rotate our upper-body / chest control and 

shoulders out to follow our arms. For a female character it is often nice 

to rotate the arms out away from the body slightly, whereas with a male 

character we want to turn them in a little. I have also taken this opportunity 

to relax his fingers. With the first frame basic pose complete, select all of 

our controls and press S to key them in place. We also want to key 

everything at frame 33. 

Now we need to build our right foot forward pose on frame 17. Starting 

with the feet copy the left foot values at frame one for your Translate and 

Foot Roll attributes and at frame 17 paste them onto our right foot values, 

then repeat the process for our other foot. Do the same process for our 

arms. The hips, chest and shoulders are easier – we simply want to put 

the negative (or positive) version of the current Rotate Y value to flip it. 

Ok, so if we play back our cycle it is already starting to resemble a nice 

walk. 



The feet are the most noticeable problems. By frame five (and 21) his foot 

should be completely planted, so let’s go in and fix this by zeroing out the 

Ball Roll attribute on these keys. 

 

Switch to the front view. We can see that his weight is way off, so let’s 

centre our feet a little. At frames one, 17 and 33 we want to bring both 

feet closer to (but not on) the centre line, at frame 25 we want to move 

our left feet out to the side and at frame nine we want to move our right 

foot out to the side. While we have our feet selected, I have also used 

the Toe Pivot attribute to point our feet out a little. 

The main thing missing now is our feet actually lifting off the floor. Select 

your feet and make sure that your Translate Y and Rotate X attributes 

are keyed at zero. Now at frames nine and 21 for your right and left feet 

respectively, rotate the foot down and lift the foot up. This should create 

a nice arc for your feet to travel in. 

We need to add some weight to our animation, at the 

moment it is looking a little too floaty. With your hips 

selected open up your graph editor, select your Translate 

Y curve and press the F key to frame it. To increase the 

illusion of weight, select your bottom keys (frames five and 

21) and click on Break Tangents to allow us 

to move the in and out tangents separately. 

We want to increase the angle in and out of these 

points to make a point. Notice the weightier bounce 

when we play back our animation. We want to use 

a similar technique to give the feet more weight as 

the hit the ground. The left foot should resemble 

something like on the right, with a sharp in tangent at frame five. 

Our right foot will be similar, with the sharp tangent at frame 21. 

Now when we play back our loop, we can see that the weighting is much more 

realistic; our footsteps much snappier. To finalise our 

feet, let’s check our leg extension on the plant and lift, 

making sure that we don’t have any over extension 



(popping). On frame nine, let’s move our body up to straighten the leg. To mirror this on frame 

25, middle click frame 25 and key the Translate Y attribute. 

In your graph editor, grab the two top points and move the tangents to give the curve more of 

a hold on the higher position and lead into the next frame better. 

This is still looking much nicer, a much more dynamic walk. Moving 

on to our balance and weight distribution, move our body left on 

frame nine and right on frame 25 to match up with where our 

characters weight is being distributed. If we 

check our graph editor, we will find that we have a step again on the 

first and last frame, so let’s select both of these points, flatten the 

tangents and then move both tangents up together. 

This will give us a nice side to side movement which we can enhance 

by rotating his hips in line with the movement. It is also nice to add 

weight to this rotation, to really emphasise the feet 

planting on the ground. Were nearly there but I’m 

still not quite happy with my foot planting – there is 

too long a delay between the heel hitting the ground and the toes. Go into 

your graph editor and bring the Foot Roll one frame sooner depending on 

your animation. 

Now we can leave the bottom half for the moment and concentrate on the 

upper body. 

Select your chest control and rotate it side to side on frames nine and 25 in 

the opposite direction of the hips. In the graph editor be sure to smooth the 

in and out tangents to remove the step from our loop. Playing the animation back you will see 

that instantly we have much more attitude going on in the walk cycle, especially from a more 

front facing angle. 

The front to back rotation is ever so slightly more complicated 

because it is reacting to the hips so it will be slightly delayed. Key 

the chest forward at frame five and 21 and straighter at frame nine 

and 25. Now after we have fixed the curve in the graph editor, we 

want to select all the curve points and Shift-Middle-Click to the right to move all the frames 

right by one frames. 



Use this same technique to animate our head nodding, but move the head Rotate X keys 

forwards by two frames. 

Our arms still look a little robotic. For our hands, repeat the steps for the chest and head but 

move the rotation keys way forward so that the start key is on frame ten. This will make our 

hands drag behind the arms to give us more fluid animation. You could also move our elbow 

key frames on by one or two frames. 

Check all of your key frames in the graph editor, especially for kinks or steps in the curves and 

also for areas where you wish to add weight. Also keep an eye on your legs for popping. 

Finally hide your curves and preview your animation using a Playblast by right clicking on the 

timeline and selecting Playblast. Although playback in Maya is a good start, sometimes the 

system can be choppy – a Playblast is much more realistic to your final outcome. 

This concludes our walk cycle tutorial. You should now be well equiped to transfer these 

techniques onto your own characters and use the same techniques to create run, jump and 

other cycles within your animation. 

 

  



Animating a Arthropod (Scorpion) 

Animating a scorpion is no simple task, even the fundamentals of a walk cycle takes some 

thinking about when you are dealing with eight legs. The key thing to remember is that 

research is your best friend so the first step is to work out how an arthropod walks. Watching 

spiders and scorpions, we can see that generally the legs work in pairs, in a logical pattern – 

so using that knowledge we can draw up a spreadsheet with frame numbers and write a plan 

for which frame each foot lands on and lifts during the cycle.  

This takes planning and patience, but you will end up with something that looks a little like this: 

Following these directions, you can start to make the laborious process of keying the feet. First 

animate your body control to get the correct timing and placement for your feet, then animate 

the feet to follow. You will find that as you go on, you will be able to animate quicker and 

quicker. 

As with any walk cycle, be sure to add weight to your feet and body movements by 

manipulating (and breaking) your tangent weights. This will go a long way to make your 

scorpion look more dynamic. 

Bear in mind that this should be used as a guide, obviously if the scorpion is in an action 

sequence then his movement will be different, and there are other times you might need to 

take some creative licence with the plan.  

 

Frames 1 3 5 7 9 11 13 15 17 19 21

R1 D D D D D D U U U U U

R2 U U U U U U D D D D D

R3 U U U U D D D D D D U

R4 D D D D D U U U U U U

L1 D U U U U U U D D D D

L2 U D D D D D D U U U U

L3 D D D D U U U U U U D

L4 U U U U U D D D D D D


